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GENERAL INFORMATION

Special Precautions 	 (Figure 2)

When cleaning optical elements, use only materials that are specifically made 
for that purpose. Further, we recommend soft, low-lint, cloth materials. To 
avoid scratching the soft lens coatings, do not use paper-based materials.

Always carry the microscope with one hand supporting the •	 base  
and the other hand on the neck , using correct lifting techniques.

Do not exchange objectives between microscopes unless you know that •	
the components have all been approved and recommended by AMG.

If liquid spills on the microscope, turn off the power immediately and •	
wipe dry.

Never disassemble or service the microscope yourself. Unauthorized •	
repairs may damage the microscope or alter its functionality, and they 
will void your warranty.

After using, cover the microscope with a dust cover.•	

Environmental Concerns	 (Figure 1)

Place the microscope on a level surface away from vibrations of other •	
pieces of equipment. To protect your microscope from environmental 
vibrations, we offer a tabletop Anti-Vibration Platform (part # AMEP-
VIP1) custom designed for EVOS.

Note: Use the 4 adjustable rubber feet  on the bottom of the base to 
adjust the microscope for uneven surfaces.

Ambient room lighting and sunlight from nearby windows can enter •	
the imaging path and affect the image. 

Electrical Information 	 (Figure 3)

The •	 power switch  is located on the back of the microscope.

The detachable •	 power cord output connection  is located next to the 
power switch.

Figure 2

Figure 1

 

Figure 3








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General Information

PLAIN STAGE

MECHANICAL STAGE

LCD Display

Plain Stage

Focus Control

LED Lamp House

Objective Select Wheel

Condenser Assembly

Phase Annuli Select Wheel

Image Capture Button

LCD Positioning Knob

LCD Tilt Knob

USB Connect Port

Power Cord
Power Switch

Adjustable Rubber Feet (4)

Secure Digital (SD™) Card Slot

Dimmer

LCD Display

Focus Control

LED Lamp House

Objective Select Wheel

Condenser Assembly

Phase Annuli Select Wheel

Image Capture Button

LCD Positioning Knob

LCD Tilt Knob

USB Connect Port

Power Cord
Power Switch

Secure Digital (SD™) Card Slot

Dimmer

Y-Axis Fine Positioning

X-Axis Fine Positioning

LCD Control

LCD Control

Adjustable Rubber Feet (4)

LCD Settings Button

Power ON Indicator

LCD Settings Button

Power ON Indicator

Coarse Positioning

Note: Install software 
before connecting USB.

Note: Install software 
before connecting USB.



	 4 EVOS™ User Guide

Specifications

EVOS Specifications

Optics Infinity corrected optical system

Standard Objectives LWD; 4xBF, 10xPh, 20xPh; 40xPh (optional)

Olympus Objectives LWD; 4xPh; 10xPh, 20xPh; 40xPh (optional)

Objective Turret 4-position, with front-mounted control

LCD Display
15”, color, 1024 x 768 pixels, controls for backlight 
contrast and saturation; adjustable positioning

Camera 3MP color CMOS

Captured Image Resolution 2048 x 1536 pixels

Captured File Format DNG file format; 3MB/image

Illumination LED, 50,000-hour service life with dimmer

Contrast Methods Brightfield and Phase Contrast

Standard Condenser 3-position turret for BF, 10x/20x Phase and 40x Phase

Olympus Condenser 3-position turret for BF, 4x Phase and 10x/20x/40x 
Phase

Filter Assemblies Brightfield: Pinhole and Diffuser filters included 
Phase: Green filter included

Focusing Dual, low-position controls with rubber grip

PLAIN Stage 196 mm x 196 mm (7.7” x 7.7”) plain stage; XX

low-position, 110 mm (4.3”) from table;XX

Working Distance with 
Condenser

62 mm (2.4”)XX

Dimensions Height: 587 mm (23.1”) with LCD raised to maximum; 
Width: 363 mm (14.3”); Depth: 449 mm (17.7”)

Mechanical Stage
x-y axis fine-positioning controls; XX

low-position, 110 mm (4.3”) from tableXX

interchangeable vessel holders available for most XX

common shapes & sizes
110 mm x 110 mm (4.3” x 4.3”) viewable areaXX

Working Distance w/ Multi-
well Stage Plate

58.0 mm (2.3”)XX

Dimensions Height: 587 mm (23.1”) with LCD raised to maximum; 
Width: 363 mm (14.3”); Depth: 449 mm (17.7”)

Weight 11.8 Kg (26 Lb.) - Plain Stage 
13.6 Kg (30 Lb.) - Mechanical Stage

Storage Device/Output Secure Digital (SD™) card or USB2 connection to PC

Software Micron(EVOS) imaging software (included)

Power Supply AC Adapter; Input 100-240V, 50-60Hz, 0.5A;  
Output 12 VDC

4x: 	 3.6mm x 2.7mm
10x:  	 1.44mm x 1.08mm
20x:  	 0.72mm x 0.54mm
40x:  	 0.36mm x 0.27mm



amgmicro.com	 5 EVOS™ User Guide

Assembly

Stage Plate Assembly

Plain Stage	 (Figure 1)

The plain stage assembly is pre-installed and pre-positioned at AMG. 
Simply install the circular stage plate  into the round opening in the 
stage..

Mechanical Stage	 (Figures 2 & 3)

For AME i2111/2 and AME 3205/6 Series (Mechanical Stage) microscopes, 
follow the procedures below before use.

Screw in the 2 1.	 coarse positioning knobs  into the front right and 
left-hand corners of the stage assembly.

Remove the 2.	 stage lock pin  on the back right-hand corner.

Note: The stage lock pin  is used to secure/hold the mechanical stage 
in place when transporting or moving the unit.

Changing Stage Plates (Mechanical Stage)	 (Figure 3)

Unscrew the two 3 mm1.	  hex screws  from the back of the stage with 
a hex tool (included).

Unscrew the 2 2.	 coarse positioning knobs  from the front of the 
stage.

Carefully lift the 3.	 stage plate  off from the stage assembly and 
replace.

Reattach all screws to secure.4.	



Figure 2



Figure 3






Figure 1





Power Cord Assembly	 (Figure 4)

Turn the 1.	 power switch  to the “” (OFF) position before connecting 
the power cord (transformer unit).

Insert the plug into the 2.	 power outlet  on the back of the 
microscope. 

Insert the 3-prong plug from the power supply into a power socket.3.	  

Figure 4


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Assembly

Figure 3



Filter Slider Assembly 	 (Figure 3)

Three filter slider assemblies are included with all EVOS microscopes. For 
brightfield applications you MUST use the Pinhole or Diffuser filter.

Due to variances in sample size, color and thickness, actual filter use may 
differ from the standard filter use described below.

Pinhole filter slider assembly•	 : brightfield, low magnification (4x/10x)

Diffuser filter slider assembly•	 : brightfield, high magnification 
(10x/20x/40x)

Green filter slider assembly:•	  may be used for phase-contrast at all 
magnifications (optional)

Note: AMG strongly recommends NOT replacing or tampering with the lens 
element as it may cause damage to the filter assembly. 

Insert the 1.	 filter slider assembly  into the filter slider slot on the 
condenser assembly.

Adjust focus, contrast, and/or illumination and view specimen on 2.	
screen. 

	important! 
	 Use a filter assembly for brightfield.

Objective Lens Assembly 	 (Figure 1 - PLAIN STAGE) 

	 (Figure 2 - MECHANICAL Stage) 

The color-coded objectives match the color-coding label on the objective turret. 

When properly installed, EVOS will “know” which objective is in place and adjust 

the lighting and image capture parameters to suit. 

Carefully remove the 1.	 circular stage plate  (PLAIN STAGE) or the 
vessel holder  (MECHANICAL STAGE) from the stage assembly.

To prevent contamination to optical components, turn the 2.	 objective 
select wheel  left 1/2 click, to move the objective turret  away 
from the optical path, before removing and installing the objective.

Install the objectives into the corresponding positions in the 3.	 objective 
turret located inside the stage assembly (see labels).

Note: Make sure the color coding on the objectives matches the color 
coding label on the turret so the automatic settings will work.

Turn the 4.	 objective select wheel  to switch between objectives. 

Please note that EVOS models AME-3201 and AME-3204 are configured for use 

specifically with the following objectives:

	   4x Phase Contrast, AMG part #AMEP-4602 (Olympus part #1U2C522P)

	 10x Phase Contrast, AMG part #AMEP-4603 (Olympus part #1U2C144P)

	 20x Phase Contrast, AMG part #AMEP-4604 (Olympus part #1U2C146P)

	 40x Phase Contrast, AMG part #AMEP-4605 (Olympus part #1U2C149P)

Use with any other objectives besides those listed above will void AMG’s warranty 

support for your EVOS model AME 3201 or AME 3204 microscope.

Figure 2

Figure 1








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Operation

Dimmer (Illumination) Control	 (Figure 1)

Turn the 1.	 power switch  to the “|” (ON) position.

Rotate the2.	  dimmer control  located on the bottom right-hand side 
of the microscope base to adjust brightness/intensity.

Illumination Pre-configured for Each Objective

The illumination/brightness levels on EVOS microscopes are preconfigured 
for each individual objective for optimal performance. The microscope is 
set to recognize each objective automatically as the objective select wheel 
rotates.

Learning Function

EVOS microscopes are equipped with a memory function that remembers 
the last automatic or manual illumination setting that was used for each 
individual objective, even after being powered off. As the objectives are 
switched, illumination values return to the last set levels for each objective.

Figure 1

 

LCD Settings Control	 (Figures 2 & 3)

The LCD settings button  gives the user direct control for the following 
LCD display settings:

BACKLIGHTXX

CONTRASTXX

SATURATIONXX

Press the 1.	 LCD settings button  to initiate settings control mode.

Turn the 2.	 LCD control  to adjust the setting (8 levels available) to 
desired view.

When finished, wait approximately 4 seconds for the settings panel to 3.	
close.

Figure 2



Figure 3


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Operation

Objective Select Wheel	 (Figure 1)

Rotate the 1.	 objective select wheel  located at the bottom center of 
the microscope base until a desired objective is in position (see label).

The microscope will automatically recognize each individual 2.	
objective and use the pre-configured illumination settings for optimal 
performance.

Rotate the 3.	 phase annuli select wheel  to the position that 
corresponds with the respective objective.

Focus Control	 (Figure 2)

Focus control 1.	  knobs are located on both sides of the microscope. 
Backward rotation will move the objective away from the specimen 
and forward rotation will move it toward the specimen.

Rotate as necessary to adjust focus of the specimen on screen.2.	

Note: Every EVOS microscope has a safety feature that incorporates a 
“slip-clutch” mechanism to protect the objectives. When the objective 
turret reaches the end of its travel range, the clutch makes a “clicking” 
sound as the focus control continues to turn. The objective does not 
move past the acceptable range.

Phase Annuli Select Wheel	 (Figure 3)

Phase rings are pre-installed and pre-aligned on the phase annuli select 
wheel  for optimal performance. Realignment or re-centering is not 
required. For all service needs, refer to the Customer Service section.

EVOS microscopes have 3 positions for phase contrast:

STANDARD OPTICS	 OLYMPUS OPTICS

brightfield (BF)	 brightfield (BF)XX

10/20x phase	 4x phaseXX

40x phase	 10x/20x/40x phaseXX

Note: View through the small window  in the front of the phase condenser 
assembly to set the phase annuli to its respective objective. The phase setting 
must correspond to the objective for proper operation. 

Figure 1



Figure 2



Figure 3






amgmicro.com	 9 EVOS™ User Guide

Operation

Mechanical Stage Operation	 (Figure 1)

The free-motion “glide” stage operates and moves in all directions —
horizontally, vertically and diagonally. 

Maneuver the stage freely throughout its x-y range of motion using 1.	
the 2 coarse-positioning knobs .

Turn either of the 2 2.	 y-axis fine-positioning controls  toward the 
front to move the stage forward and toward the back to move the 
stage backward.

Turn the3.	  x-axis fine-positioning control  counter-clockwise to 
move the stage to the left and clockwise to move the stage to the 
right.

Secure Digital (SD™) Card	 (Figures 2 & 3)

The SD memory card slot is located on the top of the LCD display.

Note: Before using the SD card, format the disk/card by following the 
manufacturer’s format disk procedures.

Gently pull out the 1.	 protective rubber cover  from the LCD frame.

Insert the 2.	 SD card  with the angled corner facing bottom left-hand 
side (see Figure 3) into the slot until it clicks and the card locks into 
position.

Remove the card by pressing it down to release it from the slot.3.	

Note: Do not remove SD card until “STORING: EVOS____.DNG” clears 
from the LCD screen







Figure 1

Figure 2



Card

Figure 3





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Operation

Image Capture Button	 (Figure 1)

The image capture button  is located on the right-hand side of the 
microscope, directly behind the right focus control.

To save an image on an SD™ card:

To capture/save an image on an SD card,1.	  insert the card into the 
card slot located on top of the LCD display as described on page 9.

Focus the image on screen to desired view.2.	

Press the 3.	 image capture button  located behind the right focus 
control.

A 4.	 “STORING:EVOS0000.DNG” display will flash on the LCD screen 
beneath the SD card slot for about 3 seconds to indicate that EVOS is 
saving the image onto the memory card.

To save an image on a PC via Micron(EVOS):

To capture/save an image on a PC via Micron(EVOS),1.	  remove the 
SD™ card from the card slot (SD card is set as default for saving images).

Connect the USB cable after the software has been installed as 2.	
described on page 11.

Launch Micron(EVOS).3.	

Focus the image on screen to desired view.4.	

Press the 5.	 image capture button  located above the right focus 
control.

Choose file name and file location when prompted.6.	

Note: Images are saved as Digital Negative (DNG) files that can be opened with 
Micron(EVOS) or other Adobe® imaging applications. Files are 2048 x 1536 
pixels in dimension and approximately 3MB in size.

Figure 1


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Operation

Micron(EVOS) via USB Connection	 (Figure 1)

The USB connection port  allows images to be viewed, captured, saved, 

edited, and analyzed directly on a PC via a USB2 cable (included) with AMG’s 

Micron(EVOS) imaging software (included)

Figure 1

System Requirements (Minimum)

PC with Pentium® IV 1.8 Ghz CPU or higherXX

Windows® XP Operating SystemXX

30 MB of hard drive space for application softwareXX

One open USB 2.0 port XX (Intel® chipset preferred)

256 MB RAMXX

IMPORTANT!  Install the software before attaching the 
microscope to PC. 

Installing Micron(EVOS) Software

Insert Micron(EVOS) software CD into CD drive1.	

At the 2.	 Welcome dialog, click Next to continue.

At the 3.	 License Agreement dialog, select “I accept the agreement” to 
continue.

At the 4.	 Select Destination Location dialog, click Next to accept the 
default application location to continue.

At the 5.	 Select Additional Tasks menu, choose desired placement of 
available icons and click Next to continue.

At the 6.	 Ready to Install dialog, review and verify install settings and 
click Install to continue.

At the7.	  Information screen, click Next to continue.

At the 8.	 Completion screen, click Finish to finalize software installation.

Installing Driver

After installing Micron(EVOS), connect the microscope to a PC using 1.	
the USB2 cable (included).

When prompted, browse to the Micron CD and select the installation 2.	
disk folder: CD Drive:\Westover USB2 EVOS Installation Disk.


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LCD Positioning	 (Figure 2)

There are 2 LCD positioning knobs  located on either side of the 
microscope that control the vertical placement of the LCD screen and 1 LCD 
tilt knob  that controls the angle of the LCD screen. Loosen and tighten as 
necessary to get the desired position for optimal view.

Figure 2





Working with DNG Files in Micron(EVOS)	

DNG (Digital Negative) files saved on the SD™ card using EVOS can be opened in 

Micron(EVOS) or other Adobe imaging applications (for installation procedures, see 

Installing Micron(EVOS) Software on page 11).

To open DNG files saved in EVOS:	 (Figure 1)

Insert the SD card with the saved image(s) into the card reader on your 1.	
PC.

Open/launch Micron(EVOS).2.	

Select 3.	 File > Open from the menu toolbar (see Figure 1).

Select4.	  Other Image Files from Files of type: drop-down list.

Once the image is opened, select 5.	 File > Save As... and choose a 
format option to save the image:

.png•	  (Portable Network Graphic)

.jpg•	  (JPEG)

.bmp•	  (Bitmap)

Note: For detailed operation procedures, go to the Micron(EVOS) User Guide 
(PDF) on the Micron(EVOS) Installation CD or select Help > User Guide... in 
the Micron(EVOS) Main menu toolbar to access the guide.

Figure 1

Operation
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Maintenance

LCD Display/Screen Care

To clean the LCD screen:

Turn the power OFF.1.	

Use a soft, dry, lint-free cloth to wipe off any dust from the screen.2.	

For blemished areas, use a cleaner that is intended for LCD (liquid 3.	
crystal display) screens only. Do not spray directly onto the screen, as it 
may drip into the display. Dampen a clean cloth to wipe the screen.

Objective Lens Care

Clean each objective periodically or when necessary with a clean lint-free 
cloth and lens cleaning solution. To avoid scratching the soft lens coatings, do 
not use paper-based materials.

Note: To protect all optical components of the microscope, use the dust cover 
(included) when the microscope is not in use.

Stage Care

Clean the stage regularly to keep it dry and clear of debris.XX

When moving Mechanical Stage microscopes, be sure to lock the stage XX

with the stage lock pin to prevent the stage from sliding around.

Note: To protect all optical components of the microscope, use the dust cover 
(included) when the microscope is not in use.
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Maintenance

Firmware Update

To update firmware:

Download the latest EVOS firmware onto an SD™ card from the AMG 1.	
web site.

Turn power OFF.2.	

Insert the SD card into the card slot.3.	

Press and hold 4.	 the Firmware Update Button (LEFT)  while 
turning the power ON (see Figure 1).

When the microscope powers on, release the5.	  Firmware Update 
Button. You will see the firmware version that is on the SD card in the 
4th line of the 2nd paragraph (see Figure 2). 

	 Firmware Rev on SD Card: X.XX 

Note: If the existing firmware version is the same as the version on the 
SD™ card, it is not necessary to update the firmware.

Push the 6.	 Image Capture Button (RIGHT)  (see Figure 1) to start the 
update.

The screen will display the update progress 7.	 (see Figure 3).

Note: DO NOT POWER OFF while the firmware is being updated. The 
update will take approximately 3 minutes to complete.

To verify firmware version:

Turn power OFF.1.	

Press and hold 2.	 the Firmware Update Button (LEFT)  while 
turning the power ON (see Figure 1).

When the microscope powers on, release the3.	  Firmware Update 
Button. The screen will display the EVOS model number, hardware 
version, and firmware version (see Figure 2).

EVOS Firmware Updater Version 1.01
EVOS Model: AME-I
Hardware Rev: 1.00
Firmware Rev: 1.01

Waiting for SD Card Insertion
Found Card -> Loading firmware
Loaded firmware.bin file
Firmware Rev on SD Card: 1.01

Push Right Button to Start Update

Figure 2

Push Right Button to Start Update
Updating Unit -> DO NOT POWER OFF <-

Chip Erase Starting
Chip Erase Complete - verifying
Erase verified
FPGA Configuration Data being written to flash
Updater Firmware being written to flash
Diag Routine being written to flash
Fonts Bitmap being written to flash
Application Firmware being written to flash
Verifying Firmware
Firmware Verified

Reset Power to complete firmware upgrade

Figure 3

Figure 1

 
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Parts & Accessories

Item Part Number

Filter Slider Assembly – Green AMEP-CFG

Filter Slider Assembly – Pinhole AMEP-AS15

Filter Slider Assembly - Diffuser AMEP-DFS1

Filter Slider Assemblies

Objectives, Olympus

Item AMG Part No. Olympus Part No.

  4x Phase Objective AMEP-4602 1-U2C522P

10x Phase Objective AMEP-4603 1-U2C144P

20x Phase Objective AMEP-4604 1-U2C146P

40x Phase Objective AMEP-4605 1-U2C149P

EVOS Microscopes with Olympus Optics

Item Part Number

PLAIN Stage: no objectives included AME-3201

Plain Stage: 4xPh, 10xPh, 20xPh AME-3202

Plain Stage: 4x, 10xPh, 20xPh, 40xPh AME-3203

Mechanical Stage: no objectives included AME-3204

Mechanical Stage:  4xPh, 10xPh, 20xPh AME-3205

Mechanical Stage:  4x, 10xPh, 20xPh, 40xPh AME-3206

Item Part Number

Vessel Holder for Slides;  
holds two 12mm x 75mm standard 
microscope slides, chamber slides, etc.

AMEP-VH001

Vessel Holder for Petri Dishes;  
holds four 35mm dishes

AMEP-VH002

Vessel Holder for Petri Dishes;  
holds two 60mm dishes

AMEP-VH003

Vessel Holder for Petri Dish;  
holds one 100mm dish

AMEP-VH004

Vessel Holder for T-flasks;  
holds two 25cm2 flasks,  
rectangular or triangular

AMEP-VH005

Vessel Holder for Nunc T-75 Flask; 
holds one 75cm2 flask

AMEP-VH006

Vessel Holder for Hemacytometer; 
holds one 76mm x 33mm standard 
hemacytometer

AMEP-VH007

Vessel Holder for BD/Greiner T-75 flask; 
holds one 75cm2 flask

AMEP-VH008

Vessel holder for all vessel types; plain 
stage functionality

AMEP-VH009

Vessel Holder for BD/Greiner T-25 flask; 
holds one 25cm2 flask

AMEP-VH010

Vessel Holders

Item Part Number

Mechanical Stage: 4x, 10xPh, 20xPh AME-i2111

Mechanical Stage:  4x, 10xPh, 20xPh, 40xPh AME-i2112

Plain Stage: 4x, 10xPh, 20xPh AME-i2101

Plain Stage: 4x, 10xPh, 20xPh, 40xPh AME-i2102

EVOS Microscopes with Standard Optics

Objectives, Standard

Item Part Number

4x Objective AMPI-OP004

10xPh Objective AMPI-OP010PC

20xPh Objective AMPI-OP020PC

40xPh Objective AMPI-OP040PC

NOTE: Objectives are not interchangeable between EVOS systems 
with differing optics packages.

Accessories

Item Part Number

Power Adapter ZP-EC-00436

Dust Cover ZP-PKG-0403

Circular Metal Stage Plate (Plain Stage) AMPI-MSP1

USB2 Cable ZP-EC-00365

Anti-Vibration Platform AMEP-VIP1

NOTE: EVOS microscopes with Olympus Optics are configured for 
use specifically with the Olympus objectives listed below. Use with 
any other objective besides those Olympus objectives listed below 
will void AMG’s warranty support for your EVOS microscope. with 
Olympus Optics.
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Customer Service

Contact Information

TOLL FREE (US & Canada)

	 Customer & Technical Service	 866-614-4022

Local & International

	 Customer & Technical Service	 425-368-0444

	 Fax	 425-368-0555

	 E-mail	 info@amgmicro.com

	 Web site	 www.amgmicro.com

Advanced Microscopy Group customer service business 
hours are 8:00 a.m. – 4:00 p.m. Pacific Standard Time. After 
hours, you may leave a telephone message. We will return 
your call the following business day. 

Disclaimer

Information provided by Advanced Microscopy Group, Inc. is believed to be accurate 

and reliable. However, no responsibility is assumed by Advanced Microscopy Group 

for its use. The information contained in this publication is subject to change without 

notice. Words that Advanced Microscopy Group considers trademarks have been 

identified as such. However, neither the presence nor absence of such identification 

affects the legal status of any trademark. Units of measurement in this document 

conform to SI standards and practices. All rights reserved. No part of this publication 

may be reproduced, stored in a retrieval system, or transmitted in any form, be it 

electronically, mechanically, or by any other means such as photocopying, recording, 

or otherwise, without the prior written permission of Advanced Microscopy Group. 

Thanks for being our valued customer! Advanced Microscopy Group, Inc. is a 

Seattle-area (Mill Creek, WA) optical equipment design and manufacturing firm 

with a domestic and international client base. Advanced Microscopy Group 

designs, develops, and manufactures optical systems and software for scientific, 

biotechnology, industrial, and educational fields.

Warranty Information

Statement of Limited Product Warranty

EVOS™ microscopes are warranted to be free of all defects in material 

and workmanship for a period of 60 months (5 years) from the date 

of delivery. The warranty does not apply to any instrument which has 

become worn, defective, damaged, or broken due to normal wear, 

abuse, misuse, tampering, or unauthorized repairs. Under this warranty, 

Advanced Microscopy Group will repair or replace, without charge to the 

purchaser, any part which, upon our examination, appears to be defective 

in materials or workmanship.  

Returned Goods Policy for Repair or Replacement Parts

To return goods for repair or replacement, please contact Advanced 

Microscopy Group Customer Service by one of the numbers at the 

left. Please be prepared to supply the following information: 

Your name, return shipping address and telephone --
number

Catalog/Model number of the item(s) you are returning--
Serial Number(s), if applicable--
Description of the product’s problem or reason for the --
return

Date the item was purchased--

Distributor information, if applicable--

A Westover Representative will issue you a Return Materials 

Authorization (RMA) number. Please label the outside of your 

shipping container with this number. For any additional information, 

please call Customer Support: 1-866-614-4022 or 1-425-368-0444.

ADVANCED MICROSCOPY GROUP, INC.
18421 Bothell-Everett Hwy

Suite 150

Mill Creek, WA 98012
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